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My Background

- Professional Experience
= Since 1998 — full-time Harper College faculty
= Eight years adjunct faculty
» Ten years information technology industry experience

« Education
> MS Information Systems
= Master Online Teacher Certificate
= Doctoral Candidate

- Awards
s« 2008 ITC Outstanding e-Learning Faculty Award for Excellence

s« 2008 MERLOT Business Classics 2008 Award
s« 2006 Blackboard Greenhouse Exemplary Online Course Award



e Standards-Based Self-Assessment
¢ Free Online Tools
e Web Design Concepts Self-Assessment

e Facilitating Collaborative Activities

* Managing Student Web Projects

* Have some fun: Wordles, You Tube, Texting ....

® Your questions / ideas / tips / sharing
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Self-Assessment
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Self-Assessment Activities

» Learner Benefits
= Early feedback
= Early reinforcement / success

= Improved success on
graded assignments

» Instructor Benefits
= Improved learner performance
s Less time grading!




Online Self-Assessment
XHTML & CSS Validators

» XHTML Validation
- http://validator.w3.org/ | ¥

WHLIDATOR

= CSS Validation
- http://jigsaw.w3.org/css-validator
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Free Browser Tools for
XHTML & CSS Self-Assessment

- Firefox Browser
= http://www.mozilla.org/products/firefox
= Multi-platform

- Web Developer Extension
= https://addons.mozilla.org/en-US /firefox/addon/60
= Created by Chris Pederick
= Validate XHTML (Tools)
= Validate CSS (Tools)
= View image information — and more
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Free Text Editor: Notepad++

- Text Editor /
- Windows Only Notepad++
e—

http://sourceforge.net/projects/notepad-plus/files/
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More on the Web Developer Extension

(&) Disable” 2 Cookies | €5+ -] Forms~ ® Images+ © Information” | Miscellaneous~ ./ Outline~ ,: Resizer f Tools* Q View Source /' Options®
A few minutes to install ... a lifetime to explore ...
= Tools > Validate Local HTML = Miscellaneous > Display

= Tools > Validate Local CSS ruler

= CSS > View CSS = Miscellaneous > Edit

- CSS > Edit CSS HTML

s Information > View Color ’ Outln.le > Outline
Information Headings

- Images > Display Alt s QOutline > Outline Block
Attributes Level Elements

- Images > Hide Background = Miscellaneous > Small
Images Screen Rendering

m]

View Source > Resize
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More Free Online Tools

» Google’s Browser Size
http://browsersize.googlelabs.com

- Adobe Browser Lab | ttp '/
https://browserlab.adobe.com

- IE NetRenderer
http://ipinfo.info/netrenderer

- Web Page Analyzer
http://www.websiteoptimization.com/services/analyze/
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Web Design Concepts & Coding

Self- Assessment

Review Games |, Rayiew Games
s Sometimes provided by textbook
publisher / author

» Example:
http://webdevfoundations.net/5e/chapter4.html

= Create them yourself!

2 oy StudyMate by Respondus

Pick a Letter http://www.respondus.com/products/studymate.shtml
Fill in the Blank

Matching

Crossword Puzzle
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Facilitating Collaborative

Activities
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Collaborative Activities

« Need:

= Industry wants students to have
experience working in groups

« Benefit:

= Collaborative activities can enhance

student learning

Liu et al. (2007), Palloff & Pratt (2001, 2007),
Rovai (2007)

e Issue:

= Collaborative activities can be time-
consuming to plan, manage, and
evaluate.
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Keys to Successful Group Activities

» Start small

« Ramp up

- Clear expectations
- Well-defined tasks
- Accountability

» Rubrics
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ldeas for Group Activities :
Start Small

- Small Groups

= Informal / Casual:

- Make a list
- Class discussion

s Progressing:
- Analyze a web page for:
contrast, repetition, alignment, proxmity
- Post a group message / class discussion
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|deas for Group Activities:
Web Design Evaluation

» Well Defined Task:
Evaluate a web site for use of
web design best practices
http://terrymorris.net/bestpractices

= Clear Expectations: e —
- Assignment Description

= Accountability:
» Rubrics
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Web Design Evaluation:
Assignment Description

1. Indicate the target audience
2. Indicate whether the site appeals to that target audience and why
3. Comment on the following components

Page Layout

Browser Compatibility
Navigation

Color and Graphics
Multimedia (if applicable)
Content Presentation
Functionality

Q-0 Qa0Dp

4. Comment on accessibility as appropriate within each of the above components

9. Suggest two ideas about how to improve the website


http://terrymorris.net/bestpractices

_ Group Evaluation Rubric (10 points) o
U A total of 10 points is available for a Group Design Evaluation. Ru b r] C

Content Content is complete, Content is complete and Ideas were Response was not
accurate and offers accurate, but lacking in new |incomplete or had ||applicable to the
new ideas. ideas, or there may be one inaccuracies, ar discussion or did not
_ o areas an opinion 15 presented||there are two or follow Netiquette.
The discussion is well  |ithout supporting facts or ||more opinions are
supported by references. presented without
dncur_nerlted best supporting facts.
practices of web Content generally doesn't
design. invite further discussion or
investigation.
Content encourages
further discussion on
topic.
Critical Clear evidence of Some critical thinking Lacking critical Lacking critical thinking.
Thinking critical thinking evident, but posting may not||thinking. Postings ||Postings tend to be
(application, analysis, ||directly address the issue. tend to address inaccurate or unclear.
synthesis, and peripheral issues.
evaluation). Postings Generally accurate,
are characterized by but with omissions
originality and relevance or clear recitation.
to the topic.
Timeliness --- Answer is on or before the Participant’'s answer||Participant did not
due date. Is late but before participate in the
the end of the discussion.
week.
Involvement — Enters discussion at least 3 — Enters discussion 2 days
and days per week and responds per week and/or fails to
Responsiveness to other students. responds to others.
Communication encourages Interaction is best
further responses, raises described as "good idea
questions or politely offers ..." and of little substance
alternative perspectives. to continue discussion.




Peer Review Example

Mod 9 Group Rating Assignment
Evaluate each group member in each criteria based on the following scale:

Above Average = 2
Awerage = 1
Below average or did not participate = [

Criteria “alue
Cooperation

Effectiveness

Farticipation

Taotal Foints

AVERAGE Foints (Total/3)

Submit your group rating with the name of each group member and the total points you assigned to
each member in your group. If you do not submit a group rating by the due date, 3 points will be

deducted from Y OUR group score.
> Wiew'Complete Assignment: Mod 3 Group Rating Assignment

19
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More Complex Group Activity:
WebQuest

» BlueFish Media DesignWebQuest
= http://webdevfoundations.net/4e/webquest.html
= Students role-play
» Instructor acts as “client”
= Multiple Milestones:

- Analysis Report P——,
+ Sample Page Layout
» Presentation

» Share Your Design



http://webdevfoundations.net/4e/webquest.html
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acilitating Groups

- Introducing a Large-Scale Group Project

= http://terrymorris.net/teamwork
» Brief module about teamwork
- Reflection Activities
* Conflict Resolution
 Peer Review Working in Teams "‘;:



http://terrymorris.net/teamwork

Peer Review Example

Name Group Project Rating Sheet

Hate each of your fellow group members an the following criteria: project contributions, idea generation,
follow through on tasks, effectiveness, and coaperation.

In the table below write the name of each group member on a separate line. Then, rate each member on
a scale from 0 to 4 in each critena. Mote that O indicates a lack of the criteria, 2 indicates average, and 4
indicates superior. Calculate the total of the scores for each person and place in the rightmost column.
An example has been done for you. BE HOMEST!

Name Contribution | Generated | Completed | Effectiveness | Cooperation | Total
to Project ldeas Tasks Score
John Doe 2 o 4 2 2 10

In the space below, write one to two sentences about each person that justifies your rating.

Example: John Doe worked well on tasks that he was specifically assigned to do by our group but he was
unable to come up with any contributions while our group wrote the Project Brief. John's only contribution
was publishing the web page for the project brief.

Write a similar naraaranh ahout each member of vour arann.


http://terrymorris.net/nccia/groupprojectratingsheet.pdf

Managing Student Web

Projects
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Student Web P I‘Oj ects |“(W’f{g{!___}j?g‘:lj*j-i,":h =

« Multiple Milestones

= Project Topic Approval e By
Planning Analysis Sheet —

Site Map

Wireframe

Project Update 1 RAM -

Project Update 2 . i

Publish & Present Project

» Rubric for each Milestone

m|

a

m|

(hmmhnﬂ "m W4 oo

a

|
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- Web Project Description and Rubrics Available from Instructor Resources
for Web Development and Design Foundations with XHTML



http://www.pearsonhighered.com/educator/product/Web-Development-and-Design-Foundations-with-XHTML/9780132122702.page

Have some fun: Wordles,

You Tube, Texting, And More
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Wordle - A Word Cloud

- Engage visual learners with a wordle
e http://wordle.net
o http://terrymorris.net/wordle
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You Tube, Animoto, and More....

—
» YouTube: http://www.voutube.com Yﬂ“ T"I]E

Valid code example:
http://terrymorris.net/nccia/youtube.html

» Almost Instant Multimedia: (o]
http://animoto.com/education |
Unlimited videos for you and your students i
Upload to YouTube:
http://www.youtube.com/watch?v=rtCZloFmHBo

- Audio message and Flash player:
http://www.audiopal.com

Ih-AudioPal.
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Text Messages

texter.

Mobile Clubs

 Our students are texting all
the time

- Ofter the option to receive s
course announcements and e e

reminders via text S
» http://broadtexter.com Pemse oy |-

° Privacy Of Cell phone iPlease select your area: -
numbers is protected! Member? Send a messag

UNHSUESCRIEBE

ﬁ:'mdbv ’

e PG

57D MSG RATES APFLY orod \'-‘:teXtel'.. ‘
Mobille Clubs
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Your Questions / Ideas

/ Tips / Sharing




Resources (1)

- Felder, R. & Brent R. (2001). Effective strategies for cooperative
learning. Journal of Cooperation & Collaboration in College
Teaching, 10(2), 69-75. Retrieved from

«  Garrison, D.R., & Cleveland-Innes, M. (2005). Facilitating
cognitive presence in online learning: interaction is not enough.
The American Journal of Distance Education, 19(3), 133-148.

« Liu, S., Gomez, J., Khan, B., & Yen, C. (2007). Toward a learner-
oriented community college online course dropout framework.
International Journal on ELearning, 6(4), 519-543.

- Morris, T. (2005). Working in Teams, Retrieved from
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Resources (2)

- Oakley, B., Felder, R., Brent R., Elhagj’ I. (2004%. Turnincg
student groups into effective teams. Journal of Student Centered
Learning, 2(1), 69-75. Retrieved from

- Palloff, R., & Pratt, K. (2001). Lessons ﬁrom the cyberspace
classroom: The realities of online teaching. Jossey-Bass.

- Palloff, R.M., & Pratt, K. (2007). Building online learning
communities. San Francisco: Jossey-Bass.

- Rovai, A.P. (200(;7). Facilitating online discussions effectively.
The Internet and Higher Education, 10(1), 77-88.

- Swan, K,, Shen, J., & Hiltz, S. R. (2006). Assessment and
collaboration in online learning. Journal of Asynchronous
Learning Networks, 10(3), 45-62.
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